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Introduction to This Guide 
 

Today you'll discover how to manage your events and coordinate the use of your facilities using PDS 

Facility Scheduler. Being able to schedule an event or meeting is important, but we'll also go over how to 

schedule multiple events for a single occasion (such as a wedding), set reminders for events, create 

custom calendars, and print them by per day, week, month, and year. 

 

If you're new to the program, we'll talk about how to set up your facility records and schedules, along 

with some defaults and preferences. Before you know it, you'll be scheduling facilities like a pro! 

 

Let's start off with another introduction 

Paula Martin has been on staff at Saint Mary's Catholic Church for almost 5 years now. She was reluctant 

to use new software at first, but after a product demo, she sees that it would eliminate a lot of manual 

work she's become used to. 

 

 
 

Paula has over 20 facilities that she tracks in a bunch of different spreadsheets. Sometimes, people 

outside the parish come by the office to ask about using a facility for an event. She gets weekly requests 

via email from parish staff and volunteers. It can get overwhelming. Paula looks forward to better 

organization and management of Saint Mary's facilities. So let's begin. 
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Unit 1: Setting Up PDS Facility Scheduler 
 

Paula's ready to jump in and start working. But before she can add her facilities, she needs to think of 

the features each one has to offer as well as what people are required to do in order to use a facility. 

She can include these on her facility records. 

 

By the end of this unit, you'll be able to: 

 Set your default preferences for Facility Scheduler 

 Schedule automatic data backups and back up your data manually 

 List the features that your facilities offer and add them in PDS 

 Add the requirements and charges necessary to use your facilities 

 

 

  



5 

 Get Started 

The first thing Paula needs to do is start Facility Scheduler. 

 

Double-click the PDS Facility Scheduler icon on your desktop to launch the program. 

 

The very first time you open PDS, the License Registration Wizard displays. This will help you create a 

new database or convert your data from a prior version. 

 

 Set Initial Options 

In the past, Paula has had people use a facility back-to-back, and they complained that the previous 

person didn't finish cleaning up until the next event was scheduled to start. So, she decides not to allow 

setup and cleanup times to overlap. 

 

And she wants to make sure Facility Scheduler automatically adds 15 minutes for setup and 30 minutes 

for cleanup for every event. 

 

There are some options Paula needs to come back to after she becomes more familiar with the PDS. 

 

You can specify various options and preferences, and set the default subdirectories. On the File menu, 

click Setup > Initial Setup. 

 

Paula is eager to add her facilities to PDS and start entering information about events at Saint Mary's. 

She's ready to get rid of the facilities spreadsheet she's been keeping track of for years. However, we 

need to set up some features about the facilities first.  

 

 Set Up Facility Features 

Paula wants to track how many people can comfortably fit in a facility, if the facility has tables or chairs, 

and other features like equipment. 

 

She takes a look at her spreadsheet that she's added on to ever since she "inherited" the document 

from Jim (the previous facilities manager). The notes she's taken on each facility over the past 3 years 

will come in handy here. 
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Figure 1-a. Paula's facilities spreadsheet 

 

 

In PDS, a feature can be anything that people can use in a facility, like tables, chairs, phones, and so on. 

You can create up to 18 facility features. 

 

 

To insert a new facility feature  

1. On the File menu, click Setup > Facility Features. 

2. The Facility Features dialog box displays. Click Insert Features. 

3. Enter a name for the facility feature. 

4. Select whether the feature uses a number or Yes/No. For example, a "seating capacity" feature 

uses a number, whereas a "projection screen" feature uses a Yes/No option. 

5. When you're finished, click Save/OK. 
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Figure 1-b. Facility features from Paula's spreadsheet 

 

When you add records for your facilities, you can indicate which features each one has. We'll get to that 

in a moment. 

 

  Warning 

           Never change the name of a feature once you've used it on records. If you no longer need to use a 

feature, you can delete it. Or if you have two similar features, you can combine them. 
 

 

 Now it's your turn 

1.   Think about one of your facilities or rooms that you know pretty well. List the features of it, 
and think about what you need to know when scheduling that facility or room. 

 

Your Facility or Room Name: _________________________________________________ 

 

Feature: * _____________________________   Is this a number of items or a yes/no? __________ 

 * _____________________________   Is this a number of items or a yes/no? __________ 

 * _____________________________   Is this a number of items or a yes/no? __________ 

 * _____________________________   Is this a number of items or a yes/no? __________ 

 * _____________________________   Is this a number of items or a yes/no? __________ 
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 Add Keywords 

Paula noticed something called keywords on the File menu when she was setting up PDS. She clicks it to 

see what it is. Keywords represent data used repeatedly in Facility Scheduler. This simplifies data entry 

and eliminates the possibility of spelling errors and inconsistent usage. 

 

She understands Address Types, City/State Names, and Phone Descriptions. For now, she focuses on 

Request Types and Requirement Types. These are essential for managing events, which we'll talk about 

in a bit. 

 

Paula gets lots of emails – too many – asking to use a facility, so that's the first Request Type she inserts. 

She wants to start an online request system for parishioners as well, and she heard PDS can do that, so 

she enters "Online" as a keyword. You can add as many keywords as you'd like. 

 

Several facilities, Paula knows, have specific requirements in order for an event to take place there. For 

instance, there's a liability insurance form to sign when using the gym. She can enter these in the 

Requirement Types list. Others include an interview, security guard, permit, and so on. 

 

 

 
Figure 1-c. Examples of requirement types 

 

 

  Warning 

If you change a keyword, all the places where you added that keyword on existing records 
are changed. 
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 Now it's your turn 

1.   What kind of requests do you get? Who makes these requests? 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

 

 

2.   Think about what it takes to use your facilities. List rooms or areas and their specific requirements 

that must be completed before people are OK'd to use them. 

 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 

* ________________________________________________________________________________ 
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 Set Up Charges & Payments 

Okay, Paula would really like to put her facility records in PDS now… but there's one more thing to do 

before she can do that. Let's look at charges and payments while Paula practices her patience. 

 

  Useful Information 

If fees never apply for your facilities, skip this. Just choose No for that option in Initial Setup. 
 

 

Paula's parish charges a $20 cleanup fee when someone uses the Banquet Hall, so she knows she'll have 

to add that one. Oh, and there's a rental charge for the parish vans that she'll need to add as well. 

 

Each charge and payment is an "activity". Related charge and payment activities can be grouped 

together to help Facility Scheduler know that when you enter an amount and call it "Clean Up Payment", 

it should be applied to the amount for "Clean Up Fee" and not the amount for, say, "Setup Fee". 

 

There are some common groups and activities set up for you in PDS. Use these predefined groups as 

they are, or change them to fit your needs. You can also add to the list or delete any you will never use. 

 

 

 
Figure 1-d. Common charge/payment groups and activities 
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There are 5 predefined activity types that instruct Facility Scheduler how to handle the amount: 
 

 A charge is an amount to be billed to the organization/individual using your facility. It could be a 

rental fee, deposit, cleanup fee, or other fee. For each one, it's best to have a corresponding 

payment. These names print on statements to help you see the outstanding charges. 

 A payment is an amount paid to you. This reduces the balance due. 

 Use the Ignore type for insufficient funds (ISF) checks. This way, you can keep a record of the 

payment but not include the amount in any calculations. 

 A Credit is not a payment but is included in payment totals. It can indicate a refund on a deposit. 

 Use Prior Due to show an amount due from a prior year. This is just like a charge. 

 

 

To add a group 

1. On the File menu, click Setup > Charges/Payments. 

2. Click Add to add a new group below the one you have selected. 

3. Select Add New Group, then click Add/OK. 

4. Enter a unique group name in the text box. 

5. Click Save/OK. 

 

 

To add an activity to a group 

1. In the Charges/Payments window, select the group you want to add an activity for. 

2. Click Add, then select Add Charge or Payment Activity Name. Click Add/OK. 

3. Enter a unique activity name. Include the group name for easier selection and better 

identification on lists and billing statements. 

4. Select the activity type. 

5. Click Save/OK. 
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 Now it's your turn 

1.   What fee groups does your parish need? What activity names do you need for each group? 

 

* _________________________________________________________________ 

  * ____________________________________ 

  * ____________________________________ 

 

* _________________________________________________________________ 

  * ____________________________________ 

  * ____________________________________ 

 

* _________________________________________________________________ 

  * ____________________________________ 

  * ____________________________________ 

 

* _________________________________________________________________ 

  * ____________________________________ 

  * ____________________________________ 

 

 

 

Okay, we've finally made it to the point Paula has been waiting for. Let's add our facility records! 
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Unit 2: Adding Records for Your Facilities 
 

Paula has all of her facilities listed in different spreadsheets on her computer. She's so ready to get them 

into one place, organized in a way that she can efficiently manage them. 

 

At the end of this unit, you'll be able to: 

 Create a record for a facility and add information and contacts for it 

 Set up subgroups and multipurpose rooms in Facility Scheduler 

 Assign general fees for the use of a facility 

 Schedule all of your facilities at one time 
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 Add a Facility 

Paula looks again at her spreadsheet. She grins at the thought that these are "her" facilities that she 

cares for. She finds her purpose in helping people have a place to do their ministry. 

 

She remembers a few months ago when her 7-year-old, Lily, received her first Holy Communion at the 

altar. That takes her back to her own childhood at Saint Mary's, where she was baptized and confirmed. 

She also married the man of her dreams, Daniel, here. 

 

These facilities are not only part of Paula's job; they're part of her life. The smile never leaves her face as 

she adds each one. 

 

You can add a single facility, such as a gym or meeting room. Every place you want to schedule is 

considered a "facility", including things like vehicles, recreation fields, parking lots, and so on. 

 

 

To add a single facility  

1. On the Information tab, click Facilities. 

2. At the top, click Add Fac. 

3. Enter the name of the facility. 

4. Enter an abbreviation of the facility name. This displays on schedules and calendars. 

5. If needed, enter additional information about the facility in the Remarks text box. 

6. Enter the facility address if it's different from the default address in your License Information 

window. Otherwise, select Use Default Address. 

7. Select the features available in this facility.  

8. In the navigation pane, click Contacts, and enter the contact information for the facility.  

9. Click Save. 
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 Add Subgroups & Multipurpose Rooms 

Paula thinks of Saint Mary's Social Center area. It's made up of three rooms (A, B, and C) that can be 

separated with partitions, as shown in Figure 2-a. 

 

 
Figure 2-a. Setup of Saint Mary's Social Center rooms 

 

She can schedule any or all of these rooms together, so she needs to set up 6 different facilities: 
 

 Facility "Social Center - A" 

 Facility "Social Center - B" 

 Facility "Social Center - C" 

 Group facility "Social Center - A/B" (with SC - A and SC - B as subgroups) 

 Group facility "Social Center - B/C" (with SC - B and SC - C as subgroups) 

 Group facility "Social Center - All" (with SC - A, SC - B, and SC – C as subgroups)  

 

That way, she can easily schedule all of the rooms at the same time. Then, during scheduling, when she 

selects the group facility, there's a Show Groups button. Paula can select all the rooms in the Social 

Center group or just certain ones. 

 

 

To set up a group facility 

1. Add each facility that will be part of this group. So, if you have classrooms 101 through 108, add 

a facility for Classroom 101, a facility for Classroom 102, one for Classroom 103, and so on. 

2. Add an additional facility for the group, and enter a descriptive name like "Classrooms". 

3. Enter a unique abbreviation. 

4. In the navigation pane, click SubGroups. 

5. Insert all the single facilities for this group that you added in step 1. 

6. Click Save. 
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Figure 2-b. Group facility for Social Center - All, with each room as a subgroup 

 

 Assign Fees 

All this talk about planning facilities reminds Paula about facility fees. If a facility has a "normal charge", 

that is, a charge that is normally associated with using a facility, she can add it in the Facilities window. 

 

For example, that fee for renting the parish vans that Paula thought about earlier – that needs to go on 

each van's facility record. 

 

 

To set up a facility charge 

1. Locate the appropriate facility. 

2. In the navigation pane, click Charges. 

3. In the Type of Charge drop-down list, select how to apply charges. 

4. Below the grid, click Insert. 

5. In the Description drop-down list, select an activity name, such as Clean Up Fee. 

6. Enter the amount for the normal charge.  

  Useful Information 

If this is a group facility, charges apply to the group, not to each facility in the group. 

 

7. Click Save. 

 

When you schedule events, this facility fee is inserted as the normal charge; however, you can remove 

it, change the amount, or add additional charges during scheduling. 
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 Schedule All Facilities as Unavailable 

Sometimes, Paula needs to close all of the parish's facilities for the same day and time. Luckily, Facility 

Scheduler has a special facility named "All (Group)" that she can use. 

 

For example, she can schedule the All (Group) facility with the Closed organization (which we'll talk 

about in the next unit) to indicate that all facilities are closed for Thanksgiving. 

 

 Now it's your turn 

1.    Do you have any facilities that are made up of smaller connected rooms? Draw the layout for one of 

those below. Then label the individual facilities you need to add in PDS to set up the group. 
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2.   List any facilities your parish charges people or groups to use, along with the cost. Note whether the 

cost changes based on a certain event, organization, personal relationship, or member discount. 

 

 

Your Facility Name: ____________________________________________   Cost: _______________ 

 

Does the cost change? _______________________________________________________________ 

 

__________________________________________________________________________________ 

 

 

Your Facility Name: ____________________________________________   Cost: _______________ 

 

Does the cost change? _______________________________________________________________ 

 

__________________________________________________________________________________ 

 

 

Your Facility Name: ____________________________________________   Cost: _______________ 

 

Does the cost change? _______________________________________________________________ 

 

__________________________________________________________________________________  

 

 

Your Facility Name: ____________________________________________   Cost: _______________ 

 

Does the cost change? _______________________________________________________________ 

 

__________________________________________________________________________________  
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Unit 3: Adding Organizations & Individuals 

That Use Your Facilities 
 

Paula keeps a list of the organizations that use the parish's facilities. For example, the local Boy Scouts 

troop meets in the Parish Life Center every Tuesday night. She also has several individuals within the 

parish, like Father Henry, who use conference rooms during the week. All of these can be added into 

PDS so they can be scheduled. 

 

At the end of this unit, you'll know how to: 

 Add records in PDS for organizations and individuals with contact information 

 Assign fees for certain organizations or people to use your facilities 

 Close all of your facilities for particular days 

 Post payments that organizations and individuals owe for the use of certain facilities 
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 Add an Organization or Individual 

Paula can add everyone she wants to schedule as an "organization", even if they aren't truly 

organizations, like the Boy Scouts. 

 

These could include "Maintenance", "Cleaning", or "Painting" to schedule general maintenance 

functions, or individuals like "Father Henry". 

 

 

 Now it's your turn 

1.   List 5 organizations or individuals that use your facilities. Remember, this can also be a function. 

 

1. ________________________________________________________________________________ 

2. ________________________________________________________________________________ 

3. ________________________________________________________________________________ 

4. ________________________________________________________________________________ 

5. ________________________________________________________________________________ 

 

 

You can add any number of contacts for an organization. Here are some tips: 
 

 Each contact shows on a separate tab: Primary, Contact 2, Contact 3, and so on. 
 

 Most organizations will usually only need one, whereas others (like an organization for 

weddings) might have as many as 8 or 9. 
 

 You can also import contacts into Facility Scheduler from PDS Church, Formation, or School 

Office by clicking Import Contact in the Contacts window. 
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To add an organization or individual 

1. On the Information tab, click Organizations & Individuals. 

2. At the top, click Add Org. 

3. Enter a unique name and abbreviation for the organization or individual. Abbreviations print on 

calendars and reports to save space. 

4. Select a number that indicates the priority of this organization or individual if a conflict occurs 

when scheduling. 

  Useful Information 

The highest priority is 1, and the lowest priority is 9. If a conflict occurs, you can schedule 

the organization that has higher priority. 

We recommend you create guidelines for priority numbers in order to keep consistency, 

especially if more than one person can add records. 
 

 

5. In the Remarks text box, enter any additional information you'd like to know. For example, if it's 

a cleaning function, you can say, "This record is used when a facility is to be closed for cleaning". 

6. At the bottom, enter the contact information for this organization or individual. 

7. Click Save. 

 

 

Paula adds the Boy Scouts organization record. She lists the leader as the primary  contact and the den 
mother as Contact 2. But she's curious about the other items on the left. Let's talk about those. 
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 Assign Fees 

Paula needs to assign fees to the Boy Scouts organization without tying them to any particular event. 

She can do that on the record she just created. 

 

 
Figure 3-a. Fees assigned to the Boy Scouts in the Charges & Payments window 

 

 

 To assign charges or payments directly to an organization 

1. Locate the appropriate organization or individual. 

2. In the navigation pane, click Charges & Payments. 

3. Click Insert. 

4. In the Description drop-down list, select an activity name.  

6. Enter the amount of the charge or payment. 

7. Click Save. 
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 Now it's your turn 

1.   Do you charge any of the 5 organizations/individuals you listed under the Add an Organization or 

Individual section? If so, how much? 

 

1.    NO   /   YES   - Fee(s): ________________________________________ 

2.    NO   /   YES   - Fee(s): ________________________________________ 

3.    NO   /   YES   - Fee(s): ________________________________________ 

4.    NO   /   YES   - Fee(s): ________________________________________ 

5.    NO   /   YES   - Fee(s): ________________________________________ 

 

 Close a Facility When It Can't Be Used 

The family life minister, Estelle, runs into the office and tells Paula that a bathroom in the gym flooded, 

and water is everywhere. Ten minutes later, Mr. James, the custodian, comes in with his shirt and pants 

soaked. His shoes slosh as he stops at the doorway. 

 

Paula scrambles to find him a towel, then makes him a cup of her favorite coffee blend, Chocolate 

Mousse Ambrosia. Mr. James tells her the leak has been contained, but the wood floors have been 

damaged, and sections will have to be refinished. Until the leak is fixed and the floors are redone, the 

gym is closed. 

 

After calling a plumber and the parish insurance agent, Paula needs to make sure no one can schedule 

the gym. Facility Scheduler includes a special organization named "Closed" for this type of situation. 

 

You can schedule the Closed organization to show that a facility can't be used for anything. (We'll talk 

about scheduling in a later unit.) Other situations include remodeling, holidays, and so on. 
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 Post Payments 

After everything has settled down, Paula sits down at her computer and tries to focus again. 

 

Okay, back in the groove. What about those fees we assigned earlier? What happens when the 

organization or individual pays that? 

 

You can post payments made by organizations and individuals for the fees involved in using facilities. 

 

 

To quickly post payments 

1. Click Processes in the Organization & Individuals navigation pane. 

2. In the navigation pane, click Processes. 

3. In the Processes window, click Quick Posting of Payments. 

4. Select either an organization or event package.  

5. Enter the date of payment, payment name, and amount. If applicable, enter a check number, or 

enter "M.O." or "Cash". 

6. Then enter any comments pertaining to this quick posting entry. 

7. Click Next. 

8. Select whether to display events related to this payment or to display all events. Select the 

event(s) the payment should be applied to, then click Apply/OK. The amount is posted. 

9. If needed, click Yes to post additional payments until all payments have been posted. 
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 Action Plan 
 

Whew, that was a lot of information! Let's take a short break to review. So far, we talked about setting 

up options, adding facility records, and adding organizations and individuals. 
 

Use the space below to write down: 
 

 Questions you need to ask when you get back to the office. 

 A list of tasks you need to do to set up PDS for your parish. 

 People you need to talk to and why. 
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Unit 4: Setting Up Your Calendars 
 

Your events probably fall into various categories. For example, Saint Mary's Catholic School hosts several 

plays at the parish's outdoor amphitheater. Paula can list those under a "School" calendar and can keep 

them separate from parish events. 

 

At the end of this unit, you'll be able to: 

 Add special days and holidays to your Facility Scheduler calendar 

 Set up different calendars for specific types of events 

 Display events just on the relevant calendar(s) 
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 Add Special Days & Holidays 

The first thing Paula thinks to put on her calendar is holidays. Those are easy enough. These can be: 
 

 Holidays (Easter, Christmas, Mother's Day, and so on) 

 Holy Days (Good Friday) 

 Birthdays (Fr. Henry's birthday) 

 Special Events 

 Anything you want to print on a certain day that doesn't have a specific time or facility. 

 

 

There are two ways to add new special days. You can: 
 

 Add individual days. 
 

 Choose from a list of predefined holidays. Use this option when you first start using PDS. 

 

To add an individual special day or holiday  

1. On the Administration tab, click Special Days & Holidays. 

2. In the Tasks group, click Add Date. 

3. Enter the name and date/range for the special day or holiday. 

4. Select how you want to calculate the event for next year. 

5. Select which event calendar(s) you want the special day or holiday to display on. 

6. Select how you want the special day or holiday to print on calendars. 

7. If you have an image to associate with the special day/holiday, click the folder icon to locate it. 

8. Click Save. 

 

You can set up a future year's calendar automatically rather than entering each holiday manually. 

 

To automatically set up special days or holidays for a new year  

1. On the Administration tab, click Special Days & Holidays. 

2. In the navigation pane, click Auto Setup for New Year. 

3. Enter the dates of the new calendars you want to create, for example 01/2016 thru 12/2016. 

4. If you want to use the dates already set up for the previous year in the Special Days & Holidays 

window, select Repeat dates already in the list. 

5. If you want to select from predefined lists, choose Select predefined dates and select each list 

you want to add. To select which event calendars use the list, click Show on which Calendars. 

6. Click Add/OK. 
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 Create Event Calendars 

Paula likes the idea of having different calendars for related events. She can add a "Church" calendar for 

all events at the parish, and a "School" calendar, where she can see all of Saint Mary's School plays and 

assemblies. 

 

She thinks of other events… oh yeah, she'll need a separate calendar just for Father Philip's meetings – 

he has a lot of them during the week! And then there's weddings, which happen aplenty around here! 

Paula keeps thinking of more and more event calendars she'd like to be able to view. Luckily, she can 

create up to 21. 

 

When you set up an event, you select which calendar the event displays on. This can be very handy 

because you may find it hard to print all events at once on a single calendar due to the size of a page. 

 

 
Figure 4-a. Paula's event calendar names 

 

 

To insert a new event calendar  

1. On the File menu, click Setup > Event Calendars. The event calendar list dialog box displays. 

2. Click Insert Names, and enter a name for the new event calendar. 

3. When you're finished, click Save/OK. 

4. Click Close. 
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 Now it's your turn 

1.   What categories of events do you have at your parish? 

 

* ________________________________________     * ________________________________________ 

* ________________________________________     * ________________________________________ 

* ________________________________________     * ________________________________________ 

* ________________________________________     * ________________________________________ 

* ________________________________________     * ________________________________________ 

 

Events 

Every event you schedule is added to the Events window, where you can view and modify information 

for a single event. To add a new event, you must use a scheduling wizard. We'll talk about that in Unit 6. 

 

On the Information tab, click Events, and click Event Calendars in the navigation pane. You can select or 

clear event calendar selections in this window at any time after you schedule an event. 

 

 
Figure 4-b. School play marked on the School and Special Events calendars 

 

  



30 

Unit 5: Setting Your Mass Schedule 
 

There are recurring masses that Paula knows must go on the calendar. These are first priority, so she 

wants to get these on the calendar so no other events will be booked in the parish at those times. 

 

By the end of this unit, you'll know how to: 

 Schedule all of your weekly masses for a certain date range 

 List intentions for particular masses and add them 

 Add an intention for a group of masses that share common elements 
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 Schedule All Masses 

Paula has a list of the daily masses that Saint Mary's holds every week. After she adds each mass, she 

can schedule all of them in one quick swoop. 

 

  Useful Information 

The term "mass" is used, but you can customize it to display the term you use instead. On the File 

menu, click Setup > Initial Setup. Under Name for Meetings, enter the term you want to use. 
 

 

 

To add and schedule all masses 

1. On the Information tab, click Mass Schedule. 

2. To insert a new mass, click Insert. 

3. Select the day of the week the mass falls on. 

4. Enter the start and end times and the name of the mass, such as "Sunday Mass". 

5. Select the facility where the mass occurs, and select the organization scheduling the mass. 

6. Select the calendar(s) where you want the mass to display. 

7. Repeat steps 1-5 for each mass you want to schedule. 

  Important Note 

Do not add multiple instances of the same mass. You can schedule recurrences. 

 

8. Select the masses in the list that you're ready to schedule. 

9. At the bottom, enter a date range. The masses you selected will be scheduled during this range. 

10. Click Schedule as Events. 

11. If there are no conflicts, click Schedule to complete the scheduling process. Click Next. 

12. To print a list of scheduled events, click Print List. To print a letter that includes event details to 

send to the organization associated with the event, click Print Letter. 

13. To return to the Mass Schedule window, click Next. 
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 Set Mass Intentions 

Paula has several masses on her list that are being offered for someone. For example, 

Wednesday's mass is dedicated to Rachel Ingram. She can track that person's name in the Mass 

Intentions window. In the navigation pane, click Mass Intentions. 

 

 

Intentions also display under Event Remarks on mass records. 

 

 
Figure 5-a. Intentions display in Event Remarks on mass records 

 

 

If the same intention is given at every Monday mass in June, for example, you can filter the list, then 

click Assign Intention to Filtered List. 

 

 
Figure 5-b. Assign the same intention to a filtered list of masses 
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 Now it's your turn 

1.   Father Henry comes by Paula's office and reminds her that he's dedicating next Wednesday's mass to 

Rachel Ingram. Paula looks at that mass and realizes she accidentally put Rachel on every 

Wednesday mass for the rest of the year. What should she do to correct this? 

 

 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________  
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Unit 6: Scheduling Events at Your Facilities 
 

You can schedule several types of events, ranging anywhere from a simple, one-time event (such as a 

fundraiser) to a series of interrelated events (like a wedding). 

 

By the end of this unit, you'll be able to: 

 Schedule a simple, one-time event in PDS 

 Schedule the same event that happens regularly over time 

 Schedule an event that lasts more than 24 hours 

 Schedule an event that you've held before 

 Receive an online request and create and register an event from it 

 Schedule a group of related events, like events for a wedding 

 Add fees for an event while scheduling it 

 Schedule a group or multiple facilities at the same time 

 Add details about the request for an event 

 Alter a schedule you've already created in Facility Scheduler 
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You can schedule different types of events. The scheduling process is similar for all scheduling wizards, 

with only a few differences. On the Information tab, click Scheduling Wizards. 

 Schedule a One-Time Event 

Paula knows there's a fundraiser coming up in two weeks to benefit the Beckmann family, whose house 

burned down in a fire. That's a simple, one-time event that doesn't have a recurring pattern, so she can 

enter it in now. 

 

To schedule a one-time event  

1. In the Scheduling Wizards window, click Schedule Simple Events. 

2. Select the organization and facility where this event will occur. 

3. Select whether charges apply for this event, and whether there are requirements. 

4. Enter the times and add the date(s) of the event. Click Next. 

5. If this event has charges, the next window displays options. Make selections, then click Next. 

6. If this event has requirements, the next window displays with requirement options. When 

you're finished making selections, click Next. 

7. Define how the event will print on calendars. If you want to, set a reminder and enter remarks 

for the event. Click Next. 

8. Enter the number of attendees (if known). Select the calendars you want the event to display on 

and how it displays on calendars. Click Next. 

9. When you're ready to schedule the event, click Schedule. 

10. Click Next. You can print a list of events that you scheduled during this process. You can also 

print a letter to the organization's contact about the event(s) you just scheduled. 

11. Click Finish. 
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 Schedule Recurring Events 

The Retired Ladies' Bingo League meets in the Social Center every Thursday afternoon. Paula can 

schedule this event with a recurring pattern instead of entering each event separately. 

 

To schedule a recurring event  

1. In the Scheduling Wizards window, click Schedule Recurring Events. 

2. Select the organization and facility where these events will occur. 

3. Select whether charges apply for the recurring events, and whether there are requirements. 

4. Click Next. 

5. Define the times, frequency, and dates for the recurring events, and click Next. 

6. If necessary, add any additional dates. Click Next. 

7. If charges apply, the next window displays with options. Make your selections, then click Next. 

8. If the events have requirements, the next window displays with requirement options. When 

you're finished making selections, click Next. 

9. Define how the recurring events print on calendars. If you want to, set a reminder and enter 

remarks for the events. Click Next. 

10. Enter the number of attendees (if known). Select the calendars you want the recurring events to 

display on and how they display on calendars. Click Next. 

11. When you're ready to schedule the events, click Schedule. 

12. Click Next. You can print a list of events that you scheduled during this process. You can also 

print a letter to the organization's contact about the event(s) you just scheduled. 

13. Click Finish. 
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 Schedule Events that Last Over 24 Hours 

The wet shoe prints on Paula's office floor from Mr. James reminds her that she needs to schedule the 

Closed organization in the Gym so no one can use it while it's being remodeled. That's definitely going to 

take more than a day, so Paula enters it as an event over 24 hours. 

 

1. On the Scheduling Wizards window, click Schedule Events Longer than 24 Hours. 

2. Select the organization and facility where this event will occur. 

3. Select whether charges apply for this event, and whether there are requirements. 

4. Enter the times and date(s) of the event, then click Next. 

5. If charges apply, the next window displays with options. Make your selections, then click Next. 

6. If the event has requirements, the next window displays with requirement options. When you're 

finished making selections, click Next. 

7. Define how the event prints on calendars. If you want to, set a reminder and enter remarks for 

the event. Click Next. 

8. Enter the number of attendees (if known). Select the calendars you want the event to display on 

and how it displays on calendars. Click Next. 

9. When you're ready to schedule the event, click Schedule. 

10. Click Next. You can print a list of events that you scheduled during this process. You can also 

print a letter to the organization's contact about the event(s) you just scheduled. 

11. Click Finish. 
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 Schedule Using Past History 

Saint Mary's annual leadership retreat happens every April. Once Paula adds it in for this year, she can 

come to this scheduling wizard when she needs to schedule the exact same event next year. 

 

To schedule an event using past history  

1. On the Scheduling Wizards window, click Schedule Using Past History. 

2. Select the organization associated with the event. 

3. From the list, select the past event that you want to use as a template, and click Next. 

4. If you selected a simple event, the Simple Event Scheduling wizard displays. If you selected a 

recurring event, the Recurring Event Scheduling wizard displays. The information from the 

existing event displays, except for the event dates. 

5. Enter the event date(s), and click Add Date to List.  

6. Click Next to step through the windows, editing any existing information as necessary. 

7. When you're ready to schedule the event, click Schedule. 

8. Click Next. You can print a list of events that you scheduled during this process. You can also 

print a letter to the organization's contact about the event(s) you just scheduled. 

9. Click Finish. 
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 Schedule Events Online 

Paula is excited about preparing a way for parishioners to submit event requests online. 

 

She can create a form to put on Saint Mary's website so parishioners can suggest events at any of the 

parish's facilities. From those suggestions, Paula can create the events that the facility can host. 

 

Create a Web Registration Form 

First, create an event registration form for your parish's website. Parishioners can submit their ideas or 

needs for an event. 

 

To create an online event registration form  

1. On the Scheduling Wizards window, click Event Online Registration. 

2. In the Event Online Registration window, select Create Web Registration Form. 

3. If you use the ACS Extend Platform to maintain your church website, select Use Our Extend 

Platform Service; otherwise, select None - Use Other Service. Click Next. 

4. Read the process description, and click Next. 

5. Enter the form name and brief introduction to display at the top of your web form. Click 

Preview to see what your form will look like. When you're done, close the form then click Next. 

6. Enter the email address of the person who should be notified after a parishioner registers 

online. Typically, this is the person at your parish who processes registrations. 

7. Enter a message to be emailed to the parishioner to confirm that the information was sent to 

your parish. When you're finished, click Next. 

8. Select whether to store or transfer the files. Enter the location to store the files or your FTP 

server information. 

9. If you're updating this form, select Overwrite the CSS file if it exists. If you're creating a form for 

the first time, don't worry about this. 

10. Click Finish (if you're storing files to a location) or Transfer (if you're transferring files using FTP). 

  Useful Information 

The HTML, CSS, and JavaScript files for your form are created after this process finishes. 

If you are the website manager, consult the Read Me file for comprehensive instructions. 

 

11. Copy the files that were created and send them to your website manager. These files contain 

the form that needs to be put on your website. 
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Check & Register Event Requests 

After parishioners complete and submit the online form, you decide whether to host it. You can view 

registrations, add new events, or update existing events. 

 

 

To check for and process registrations  

1. On the Scheduling Wizards window, click Event Online Registration. 

2. In the Event Online Registration window, select Check and Register Events, and click Next. 

3. Select the event(s) you want to schedule. 

  Useful Information 

If you no longer need a registration for an event, select Delete Form to remove it from the 

web server after completing this process. 
 

 

4. Review the information for the event you're scheduling. Make any necessary selections or 

changes. When you're ready to process the registrations, click Next. 

5. If you're scheduling a simple event, the Simple Event Scheduling wizard displays. If you're 

scheduling a recurring event, the Recurring Event Scheduling wizard displays. The information 

from the web form displays. 

6. Since you're scheduling this event because of a request, click Enter Request Info, and enter the 

information. Click Apply/OK. 

7. Click Next to step through the windows, editing any existing information as necessary. 

8. When you're ready to schedule the event, click Schedule. 

9. Click Next. You can print a list of events that you scheduled during this process. You can also 

print a letter to the organization's contact about the event(s) you just scheduled. 

10. Click Finish. 
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 Schedule Event Packages 

Sometimes, an event involves more than just scheduling one organization at one facility. Paula thinks of 

all the things that have to happen before a wedding. The wedding ceremony is one event, but it's 

preceded and followed by many other events, such as an interview, counseling sessions, rehearsal, and 

reception. To handle this type of event, Paula can add an event package. 

 

So What Is an Event Package? 

An event package is a series of interconnected events. A main event can have several smaller events, 

and each smaller event can have its own charges and requirements. 

 
Figure 6-a. Many events go into one big wedding package 

 

In Facility Scheduler, this idea translates into an event package record, as shown in Figure 6-b. 

 

 
Figure 6-b. Example of a wedding event package 
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Other examples of event packages include funerals, social events, leadership training. You may also 
want to add a maintenance package if your parish requires bids and contracts. 
 
 
Before You Add an Event Package 

You must set up elements for the package before adding it. Do the following: 
 

 Set up the templates for packages. A good template contains every event, charge, and 

requirement necessary for the event package. 
 

 Set up the organization and contact names. You can set up a generic organization, such as 

"Wedding", to use for similar event packages. 

 

 

Set Up Templates 

There are several predefined templates installed in Facility Scheduler. Use these to create an event 

package, or create your own templates. 

 

To create a new template, event name, requirement, or charge 

1. On the File menu, click Setup > Template for Event Packages. 

2. In the list, select the line above where you want to insert the new item, then click Add. 

3. Select the item you want to add to the list, then click Add/OK. 

o Add Template — If you add a new template, enter the template name.  

o Add Event Name — If you add an event name, enter the event name. 

o Add Requirement — If you add a requirement, enter or select the requirement. 

o Add Charge — If you add a charge, enter or select the charge activity name. 

4. To add another item, click Add again. After you finish adding items, click Save/OK. 

5. After all items are added, you can click Reorder to rearrange the items in the list. 

6. When you finish defining your templates, click Close. 

 
 
Add an Event Package 

After you set up templates, you're ready to add event packages for any upcoming weddings, funerals, 

maintenance, and so on. 

 

To add an event package  

1. Click Event Packages on the Information tab. 

2. At the top, click Add Pkg. 

3. Enter the package name. For example, "Holmes & Johnson Wedding". 
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4. Select the organization scheduling the event package, and enter remarks about the event 

package, if necessary. Click Next. 

5. From the list on the left, select items to include in the package. Click the right and left arrows to 

move items from one list to the other. After you move all the items you want to include in the 

list on the right, click Next. The events display in the Events Left to Schedule grid. 

6. For each event, enter the date, facility, and starting and ending times. If any conflicts occur, the 

details display. 

7. To schedule each item, select Mark to Schedule. The Simple Event Scheduling wizard displays. 

8. As you schedule each event, it displays in the Scheduled Events grid. 

9. You can click Finish at any time. If you click Finish before you finish scheduling the events, the 

Schedule Now button displays next to the event in the Package Events window. Or when you're 

ready to continue scheduling the events, click Complete Schedule in the navigation pane. 

 

 

Some contacts for a wedding are unique to the wedding, such as the bride, groom, best man, mother of 

the bride, and so on. However, some contacts are the same for all weddings, like the pastor, wedding 

coordinator, organist, and so on. We recommend adding these people as contacts for the "Wedding" 

organization. That way, you can add them quickly in this window. 

 

To add a new contact 

1. Locate the event package you want to add a contact to. So if you're adding the bride, you'd open 

the Wedding record associated with her wedding. 

2. In the navigation pane, click Contacts. 

3. Under the contact section, click Add. 

4. You're prompted to use a contact from the organization that scheduled the event package. 

5. If you're adding a contact unique to the wedding, such as the bride or groom, click No, and 

manually enter the contact information. 

6. To use one of the organization's contacts, click Yes, select the contact, and click Use/OK. 

7. Click Save. 
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You may need to add a requirement (like a form or contract your parish needs) that wasn't in the 

template you used. You can add those in the Package Events window. 

 

To add a requirement to an event package  

1. Locate the event package to modify. 

2. In the list, select the event you want to add to, and click Add Item. 

3. Select Add Requirement, then click Add/OK. 

4. Enter or select the requirement. 

5. Click Save. 

 

 

Schedule a Package 

Now that you've added the event package, you can schedule the events in it. 

 

To schedule an event package  

1. On the Scheduling Wizards window, click Schedule Event Packages. 

2. Select the event package, and click Next. 

3. The grid at the top displays unscheduled package events with a status of "Incomplete". 

4. Click an unscheduled event line, and enter the date, facility, and starting and ending times. 

5. If there are no conflicts, select Schedule Now. The Simple Event wizard displays. 

6. Step through the scheduling wizard, entering all the necessary information. 

7. After you schedule an event in the package, it displays in the Scheduled Events grid. Repeat 

these steps for each event you want to schedule. 

8. After you schedule all remaining events, click Finish. 

 

 

Now let's talk about some things you can do during the scheduling process, no matter what 
type of event it is. 
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 Assign Fees 

For some events, Paula wants to be able to add or change a fee. For example, the parish allows the 

Retired Ladies' Bingo group to use the Social Center at a discounted rate, so the "normal" fee for that 

facility wouldn't apply. Paula can change the fee when she schedules the bingo events. 

 

 If charges apply to an event, select Yes for the Will Charges Apply? option. 
 

 If a facility has a normal charge, Yes is selected by default. Otherwise, the default is determined 

by what you selected during Initial Setup. 

 

 

 
Figure 6-c. Charges will apply for this event at Social Center - All 

 

 

When you click Next, there's an additional step in the wizard where you can enter charges for this event. 

If the facility already has charges, they're listed here. Paula deletes the line for the normal charge, and 

inserts the discount for the Retired Ladies. She adds a comment that lets others know why the fee is 

reduced. 

 

 

If you're scheduling multiple dates, you can select how to apply the charges: 
 

 Apply to first date — Posts all charges to the first event, using the date of the first event. 
 

 Apply to each date — Posts a charge to each event in the list. 
 

 Custom billing (Enter individually) — Use this if each event has a different charge or when the 

charge should be billed to the last event. 
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 Schedule a Group or Multiple Facilities 

When Paula schedules the Social Center - All facility, the process schedules an event for each of the 

subgroup facilities (SC-A, SC-B, and SC-C). But sometimes Paula only needs rooms B and C for an event. 

During the scheduling process, she can click Show Groups to see all the facilities in that group and select 

only those she needs. 

 

 
Figure 6-d. Social Center - All (Group) is made up of facilities A, B, and C 

 

Alternatively, she doesn't have to set up groups in order to schedule multiple facilities at one time. 

During the scheduling process, she can click Multiple Facs to select the facilities that need to be 

scheduled together for an event. 

 

 
Figure. 6-e. Choose multiple facilities, even if they aren't grouped together 
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 Event Request Details 

Paula is very detail oriented. She wants to know the date of each request, who asked for an event, and 

any other comments. Lucky for her, she can conveniently add request details during scheduling. 

 

 
Figure 6-f. Enter request info from the scheduling process 

 

To add request details during scheduling 

1. Click Enter Request Info. 

2. Enter the request date, and select the request type. 

3. In the Requested By field, select the contact's name. The names in this list come from the 

Contacts window for the organization that scheduled the event. 

4. Enter any additional remarks about the request. 

5. Click Apply/OK. 

 

You can also add request details directly on the event record. 

 
Figure 6-g. Enter request info in the Events window  
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 Alter an Existing Schedule 

Paula is starting to feel a little overwhelmed, but she's still hanging on. However, if she happens to make 

a mistake along the way, there's an easy way to fix it. 

 

She can make changes to a group of previously scheduled events, if needed. 

 

To alter an existing schedule  

 Important Note 

This process alters data. We recommend backing up your data before proceeding. 

 

1. On the Information tab, click Events. 

2. In the navigation pane, click Processes. 

3. Click Alter Existing Schedule. 

4. Select the criteria to use for the events you want to change. For example, you can alter all 

events within a certain batch, alter events marked to be rescheduled, alter all scheduled events 

for a particular facility, and so on. 

5. Select an option for event calendars. If needed, select the calendar(s). Click Next. 

6. Select the check box beside the events you want to alter, then click Next. 

7. Select the event information you want to alter. As you select each option, make any necessary 

changes at the bottom of the window. Click Next. 

8. Review the alteration criteria, then click Next. 

  Useful Information 

You can schedule conflicting events and resolve the conflicts later. When you click Finish, 

you must confirm that you want to schedule the conflicting events. 
 

 

9. Click Finish. 
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 Action Plan 
 

We've gone over a lot so far! Since our last Action Plan stopping point, we've learned how to set up 

event calendars and mass schedules, as well as how to schedule events at your facilities. 
 

Take this time to write down anything you need to before we continue on to the next unit, such as: 
 

 What additional tasks you need to do when training is finished. 

 Tips that you learned along the way. 

 Areas or situations you still have questions about. 
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Unit 7: Viewing & Printing Information 
 

During office hours, Paula generally just needs to see a quick view of this week's events. But she does 

print out the monthly calendar for several volunteers and congregants who like to see upcoming events. 

And often times, Father "Last Minute" Philip swings by her office and asks if his meeting room is 

available the next day. 

 

By the end of this unit, you'll know how to: 

 View and print daily, weekly, monthly, and yearly calendars 

 See and print a list of scheduled events 

 Publish calendars to your website for parishioners to view 

 Export your event calendars and events to Google Calendar 

 Check whether a facility is available for use 
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 View & Print Calendars 

Many times, Paula just needs a quick look at her events or a calendar. There are several ways to that in 

Facility Scheduler without printing out a calendar or list. 

 

On the Information tab, click Calendars. In the navigation pane, you can get to the events listing screen 

and four schedules/calendars. 

 

List of Scheduled Events 

The List of Scheduled Events displays a complete list of events in date and time order. Current and 

future events display in black text, and previous events display in blue. 

 

By default, the focus is on today’s date. When scrolling through this list, click Move to Today to get back 

to today’s events. 

 

Schedules 

In the navigation pane, click Daily Schedule to see a daily calendar of events in order by time. 

 

Each column displays a different facility, and each row shows a different time period. Organizations 

using the facility during that time appear in yellow event blocks. 
 

 
Figure 7-a. Daily events for August 8,2016 
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In the navigation pane, click Weekly Schedule to see all scheduled events for a week. 
 

 
Figure 7-b. Events for the week of August 7, 2016 

 

In the navigation pane, click Monthly Calendar to view a monthly overview of scheduled events. If the 

day has multiple events, use the small scroll bar next to the day to view all the events.  
 

 
Figure 7-c. Events for the month of August 2016 
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In the navigation pane, click Yearly Calendar to see a yearly overview of scheduled events. No details 

about individual events are shown on this calendar, but you can use the filter to identify dates used by a 

specific organization or events scheduled in a certain facility.  
 

 
Figure 7-d. Yearly view of events in 2016 

 

You can also click the Year at a Glance button when available in a window to display the yearly calendar. 

 

 

Print Calendars 

You can print the calendars as display in these windows. 

 

If you want to customize calendar settings or define only specific information, print the 
calendars as reports: 

 To locate reports, click the Reports tab or click Reports in the navigation pane. 

 The Event Reports, Organization & Individual Reports, Facility Reports, and Event Packages 

Reports windows contain a report section called "Calendars". 

 Expand this listing to see the preinstalled calendar reports. 
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Fit More on Your Monthly Calendar 

If only a piece of paper could be the size of your office wall! The best possible monthly calendar would 

print all events for every day, but somehow fit the entire month on a single sheet of paper. 

 

In reality, you will find that there is a limit to how many events can comfortably print on your calendar. 

Here are a few suggestions for adjusting your calendar: 
 

 Reduce the font size. A font size of 6pt is legible and conserves space on your calendar. Click 

Modify the Layout of the Event Information, highlight the text, then change the font size. 
 

 Print events by category, using the event calendar categories you defined during setup. This 

reduces the size of a single calendar. For example, you can print separate monthly calendars for 

events on the Wedding calendar, the School calendar, the Maintenance calendar, and so on. 
 

 If you have a group facility for facilities that are routinely scheduled together, select to only print 

the group name on the calendar. On the Facility selection tab, select an option under How to 

Handle Events Connected to a Group Facility. 
 

 Do not print pictures. While attractive, they take up space on your calendar. 
 

 In the Calendar Layout window, reduce the minimum height. The day will expand to fit all 

events. So, if it's set to 0.50 inch, but the events do not fit in that space, the box automatically 

adjusts to fit the events. 

 

At some point, even after following these suggestions, you may find you can’t fit everything on a single 

page. The monthly calendar allows an unlimited number of events to print on a single day and expands 

the calendar to multiple pages when necessary. 

 

 Online Calendars 

Along with the online request system, Paula wants to add a calendar of events that parishioners can 

view on Saint Mary's website. She has two options: create a customized web calendar or upload her 

events to the parish's Google Calendar. 

 

For now, Paula has to deal with the limitations of the parish website. But, after talking it through with 

her web admin, she is hopeful that they'll be able to use Google Calendar in harmony with the website. 
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Build a Calendar for Your Website 

Web Page calendars create a file you can upload to your website. Instead of printing, you click Build to 

create the necessary file. Under Event Reports, click Calendars, then select one of the calendars. 

 

 
Figure 7-e. Web Page Calendar 

  
Figure 7-f. Web Page Calendar with Scrolling 

 

To set up and build your web calendar files  

1. Select the web page calendar you want to create. 

2. In the Web Page Properties window, enter the path where you want to build your .htm files.  

3. Make any additional selections you want to include on your web calendar. 

4. If you use FTP to transfer files, select Use FTP Transfer, and enter your FTP information. 

Otherwise, leave this section blank. Click Next. 

5. Select which event information to include on the web calendar using the selection tabs. 

6. When you're finished, click Build. 

7. To view the webpage, click View File. 

 

Export Events to Google Calendar 

You can upload Facility Scheduler calendars and events to your parish's Google calendar. You must have 

a Gmail account set up for your facility before exporting calendars and events. 

 

Be sure the user settings for your parish's Google Sites account are set to your time zone. 

 

To edit your time zone in Google Sites  

1. In your Internet browser, go to http://sites.google.com and log in. 

2. Click the gear icon, and select User Settings. 

3. Change the time zone to reflect your time zone, then save your changes. 

http://sites.google.com/
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Before uploading events, you must allow PDS to access your parish's Google calendar. 

 

To authorize access to your Google calendar  

1. On the Reports tab, click Event Reports. 

2. Expand the Calendars heading, select Export to Google Calendar, and click Next. 

3. Click Next. 

4. Click Authorize Access. 

5. Enter your parish's Gmail address and password, then click Sign in. Your parish's account 

information is saved after you complete the upload process for the first time. 

6. A code displays automatically in the field. Click Continue. 

7. If you agree to give permission, click Accept. 

 

After you allow access, you can upload calendars and events anytime. 

 

To upload calendars and events to Google 

1. Open the Export to Google Calendar report wizard. 

2. Select the upload options and any optional selections you want. 

o Upload Options — Select from these to specify which calendar(s) the selected events are 

uploaded to. You can create a calendar for specific Facility Scheduler topics like church 

events and school events. In the options, "Facility Scheduler Calendars" refers to any 

calendars you create for this purpose. 

o Optional Selections — Select any of these actions to perform during the upload. If you 

made changes in Facility Scheduler and want to upload events with the new information, 

select a Delete option. 

3. Click Next. 

4. Use the Select Events window to specify an event date range, times, and any other 

specifications. When you're finished, click Upload. You can preview the events before uploading. 

5. To post the selected events to your parish's Google calendar, click Upload. 

6. When the upload is complete, click View Summary to print a list of the uploaded events. 
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You can then view your events in your parish's Google calendar. 

 

To view your parish's calendars on Google  

1. In your Internet web browser, go to www.google.com. 

2. Click Calendar at the top of the page. 

3. Click an event to view or edit details. 

4. See Google Calendar Help on editing your events for additional tips. 

 

You can also share your calendars with your parishioners. For assistance, consult Google Calendar Help. 

 View Listing Screens 

When Father Philip stops by, asking about his meetings for the week, Paula needs a quick way to see his 

list. She can go to the Events listing screen and filter it by the "Fr. Philip's Meetings" event calendar she 

set up. She can also see listing screens of the organizations/individuals, facilities, and event packages. 

 

Each listing screen has default columns, but you can customize them. You can also print the list.  
 

 
Figure 7-g. The Events Listing Screen 

 

Inactive records and events marked as "Reschedule" display in red text. Events with a date that has 

passed appear in blue. An ellipsis (…) at the end of an entry means you are seeing incomplete 

information. When you hover over the ellipsis, the complete information displays. 

http://www.google.com/
http://support.google.com/calendar/bin/topic.py?hl=en&topic=1672446&parent=1665164&ctx=topic
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 Check a Facility's Availability 

As previously expressed, Father Philip likes to schedule his meetings, oh… ten minutes in advance. Paula 

needs to be able to see if a facility is available at the time he needs it. 

 

Fortunately, she can do that with the Check Availability wizard. This doesn't only see if a certain facility is 

available. Paula can also: 
 

 Find any facility that is available on a particular date and time. 

 Find any facility with certain facility features that is available on a particular date and time. 

 Check all days, weekends only, weekdays only, or selected days of the week. 

 

 

To check for availability and schedule an available facility  

1. On the Information tab, click Check Availability. 

2. Select a method for checking facilities. 

o If you check by name, select a facility name. 

o If you check by features, select any features you want, then click Apply/OK. 

3. Click Next. 

4. Enter the hours of facility availability to check, the number of minutes that the facility must be 

available (including setup and cleanup time), and the date range of facility availability to check. 

5. Click Next. 

6. In the grid, select the facility or facilities you want to schedule, and click Next. You can select 

one facility per day. The scheduling wizard for the event displays. 

7. Complete the wizard for the event you want to schedule. 
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 Now it's your turn 

1.   Father Philip comes running into Paula's office. He needs to know where he can meet with his team 

in 30 minutes. He needs space for 10 people, and he wants a white board and laptop connection. 

He'll need the room for one hour. How can Paula find a suitable meeting room? 

 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________ 

 

2.   Can you think of any other ways Paula could do this? Be creative… 

 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________ 

 

3.   Come on, you can come up with one more way. Think outside of the box here!  

 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________  
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Unit 8: Working with Reports 
 

Reports are essential, in Paula's opinion. She's excited to learn that PDS can pull together any fields she 

wants, and she doesn't have to go searching through all of her spreadsheets and emails! 

 

At the end of this unit, you'll know how to: 

 Select, preview, and print a predefined report 

 Build your own custom report with the information you want to see 

 Export data to a file that you can use in a word processor, a spreadsheet, Microsoft® Outlook®, 

Calendar Creator, or another program 
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 Find Those Reports! 

You can get to reports from different locations in Facility Scheduler. In the major areas (Events, 

Organizations & Individuals, Facilities, and Event Packages), you'll see the link to Reports in the 

navigation pane. Or, you can view all reports from the Reports tab. 

 Select, Preview, & Print Predefined Reports 

Here's a brief outline of the report process. 

1. Select the report. 

2. Review the report overview. 

3. Select the printer. 

4. Select the report layout. 

5. Select the data you want to print and the order to print it. 

6. Preview and print the report. 

 

First, you must select WHICH report you want to print. In the Select Report window, expand report 

sections by clicking the triangles. To select a report, click it and click Next. 
 

 
Figure 8-a. Selected List of Facilities report under Facility Reports section 

 

In the Overview window, you can view the basic settings for the selected report. Click Next and proceed 

through the report wizard. 
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Next, you must indicate WHERE the report will print. In the Select Printer window, you can select the 

printer to use, the paper size, and the paper source. You can also switch the page orientation from 

portrait to landscape mode, which is helpful if you have a report with many columns. 
 

 
Figure 8-b. Default printer options 

 

To change the printer-driver controlled properties of the selected printer, click Properties. The options 

available in the Size and Source drop-down lists depend on the selected printer. For example, an Inkjet 

printer may only have one or two tray sources, whereas a Xerox copier may have multiple tray sources, 

such as tray 1, tray 2, tray 3, High Capacity tray, Bypass tray, and so on. Once you make your selections, 

click Next to continue. 

 

The third step is to indicate HOW the report will print. In the Layout window, select layout options for 

page style, margin style, and the various parts of the report. These options depend on the type of report 

you’re printing. 

 

 
Figure 8-c. The Layout window for a letter report 
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Once you select your layout options, click Next.  

 

Now it's time to indicate WHICH data you want to print. In the Selection window, enter the criteria you 

want to determine which records print. For example, if you want to send a letter to specific 

organizations, you can define a "selection" for those organizations based on certain conditions, or you 

can select individual records from a list. 

 

The Selection window is divided into two parts: 
 

 The List of Selections on the left shows saved selections previously created for this report. 
 

 The Selection tabs across the top have options for what information prints on the report. 

Depending on the type of report, the following tabs may display: Selection Information, 

Contact, Org, Facility, Event, Other Event Info, Package, and Additional Selections. 

 

 

If you create selection criteria that you will use over and over again, you can save it under the List of 

Selections. Sometimes Paula needs to print information for just the Social Center facilities, so she adds a 

Social Center Only selection, as shown in Figure 8-d.  

 

 
Figure 8-d. Selection for the Social Center facilities only 
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Once you have selected the information to include in the report and the order you want it to print, click 

Preview. Here, "what you see is what you get". Examine the report and ask yourself: 
 

 Are the margins set as intended? If you select Smallest Margins, the report prints very close to 

the edge of the page. You probably wouldn't want this for a letter. 

 Are the styles (fonts, letterheads, closings, page numbers, and dates) set as intended? 

 Does the report include selected information as intended? 

 

When you like what you see and you're ready to print the report, click Print. Make your selections, and 

click OK to send the document to the selected printer. 

 

 Build Custom Reports 

Paula is pretty good at pulling information together from her records and email into a report, but she's 

nervous about how to do that in PDS. 

 

One helpful tip to alleviate some of this anxiety is to copy an existing report that's similar to what you 

need, then shape it to meet your needs. That's much easier than creating a new one from scratch. 

 

To copy a report  

1. On the Reports tab, click the button related to the type of report you want. Click the triangle 

next to each group of reports to expand it and see the individual reports. 

2. Select a report, and click Copy. The report is added to the appropriate Easy Reports section, with 

the report name preceded by "(COPY)". 

3. Click Next. Edit the name and description to describe the purpose of the report. 

4. Select a report owner, and designate report access. 

5. Click Next and follow the report wizard to define and customize the report. 
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If you can't locate a report similar to what you need, add a new report. 

 

Before Paula adds a new report, she outlines the information to include and makes notes about the 

formatting she wants. This way, she'll have something to work from when adding her new report, which 

are called "Easy Reports" in PDS. Paula smirks… yeah, we'll see how "easy" they are. Don't be so 

pessimistic, Paula! This name just refers to the fact that you can add a custom report. 

 

To add a custom report  

1. On the Reports tab, click the button for the type of report you want. Click the triangles to 

expand each group where you want your report to live. For example, if you're adding a letter to 

the parents of a bride, expand Event Package Reports. 

2. Once you're in the appropriate report group, click Add. The Add Report dialog box displays. 

3. On the Simple Reports tab, click the type of report you want to create. The new report called 

"New <type> Report" is added to Easy Reports section of the group you selected.  

o For some reports (list and export reports, for example), the List of Fields to Print dialog box 

displays, and you can define the fields you want to include in your report. 

o For other reports (letter, label, and envelope, for example), the Editing window displays, and 

you can define the content of your correspondence. 

4. Edit the name and description of the report. Select a report owner, and designate report access. 

5. Save your changes, and continue the report wizard to print your report. 

 

When adding a new report or copying an existing report, you have ownership of that report and can 

specify if only you and the administrator have access, if you want to share it but not allow anyone to 

modify it, or if everyone should be able to print and modify it. 

 

You can save your Easy Reports to a reusable storage device or hard drive to protect them from loss. 

You can also install your Easy Reports on other computers in your office or share them with other 

organizations that use PDS.  

 

To save an Easy Report  

1. In the Select Report window, select the report that you created. 

2. Click Save as Custom Report. 

3. In the Save Custom Report Files dialog box, find the location where you want to save the report.  

4. Enter a file name, and click Save. 
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 Now it's your turn 

1.   What kind of custom reports would be helpful for your daily work? 

 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________ 

 

 Export Data to a File 

Paula is feeling good about Facility Scheduler, but it may be a while before she can let completely go of 

her spreadsheets. That's all she's known up to this point – she can't just toss it all! 

 

One of the most common custom reports is an export report. Export reports are similar to list reports, 

but the data is sent to a file rather than a printer. So Paula can export information to a word processor, a 

spreadsheet, Microsoft® Outlook®, Calendar Creator, or another program. 

 

 

To define an export report  

1. In the Select Report window, select the report category where you want to add the export. 

2. Click Add > Export. The List of Fields to Print dialog box displays. 

3. Select the field names you want to include and click the right arrow button to move them to 

Fields you want to print. Click Save/OK. 

4. In the Overview window, click Edit to enter the report's name and description. If you have 

access to designate reports, select a report owner and report access. Click Next. 

5. In the Export Properties window, click the File Format drop-down list to select one of the 

following file formats: 
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o Comma Separated Values (CSV) — Creates a text file with data items separated by commas. 

This format includes headings. 

o XML — Creates an Extensible Markup Language file for sharing data on the web. 

o Line/Form Delimited — Creates a file with a line feed at the end of each field and a form 

feed at the end of each record. 

o Line/Form Delimited With Headings — Creates a file with column headings, a line feed at 

the end of each field, and a form feed at the end of each record. 

o Tab Delimited — Creates a text file with data items separated by tabs. 

o Tab Delimited With Headings — Creates a text file with column headings and data items 

separated by tabs. 

o Fixed Width — Creates a file that always prints the same number of characters for a field. 

So, if you print Org Name (75 characters), Contact Name (30 characters), and ZIP Code (15 

characters), the file always contain exactly that number of characters for those fields. If it 

has more than these, it's clipped. If it's shorter, the length is filled with spaces. 

o CSV Without Headings — Creates a text file with data items separated by commas, but does 

not include headings. 

6. Enter the name of the file you're creating. 

7. To alter the list of selected fields, click Modify the List of Fields to Export. 

8. Click Next. 

9. Make any additional selections you want. Click Build to export the data to a file. 

 

 

After exporting, you can send the file to a coworker, and they can import it into PDS using the Add > 

Custom Report option. 
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 Action Plan 
 

Quick! Before you lose all those great ideas floating around in your head, jot them down here. 

Write down any details you need to think about or things to do when you get back to your parish. 
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Unit 9: Protecting Your Work 
 

Before he moved on from managing facilities, Jim told Paula about a tornado that happened 10 years 

ago. It damaged part of the church, and Jim's computer was ruined. The last backup he made was over 2 

weeks old, so he lost all his changes and emails during that time. 

 

At the end of this unit, you'll know how to: 

 Schedule automatic backups for particular days of the week 

 Back up your data manually before a big change 
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 Back Up Your Data 

Guarding against loss due to a natural disaster, like the tornado at Saint Mary's, or a database corruption 

is important. 

 

 

Automatic Backups 

If you use OnDemand, your data is backed up automatically each night and stored on the server, so you 

don't need to schedule automatic backups. Otherwise, you can set PDS Facility Scheduler to perform 

backups automatically on selected days. 

 

Before you set up automatic backups, make sure that: 
 

 PDS is installed on the computer or server that stores the data. 

 The computer or server is on at the time when the automatic backup is scheduled to run. 

 All other PDS users are logged out. 

 You entered your email address in the License Information window. If there's a problem with 

the backup, you'll get an email. 

 

 

To set up automatic backup options 

1. On the File menu, click Backup/Restore > Backup Options. 

2. Select the day(s) you want to run an automatic backup of your data. 

3. Enter the path for the location of your internal archive folder where your backups will live. 

4. Select a level of protection for your data. 

5. Click Close. 

 

 

Paula sets her automatic update to run every week on Tuesday and Friday. However, she'd also like to 

back up her data before she makes major changes. She can run a manual backup at any time. 

 

Manual Backups 

Before you manually back up your data, make sure: 
 

 You have at least 0.5 MB of free space to complete the backup. 

 You disable your computer's Hibernate, Sleep, or Stand By options. 

 All PDS users are logged out. 

 Your backup media is preformatted. 
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To back up your data manually 

1. On the File menu, click Backup/Restore > Backup Data. 

2. Enter a backup reason. This prints on the report and displays if you need to restore the data. 

3. Select a backup method. You can: 

o Back up to a selected drive such as a floppy disk. 

o Back up to a specific folder such as the hard drive, CD-ROM, or any other drive. 

o Back up to an Internet FTP Server send the data to a website (File Transfer Protocol). 

4. Select a backup location, or enter your FTP Server information. 

5. Click Start Backup. 

 

 

 Now it's your turn 

1.   When should you use automatic backups? What day(s) are best for your parish to back up data? 

 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________ 

   Sunday        Monday        Tuesday        Wednesday        Thursday        Friday        Saturday 

 
2.   At your parish, when would you need to back up your data manually? 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________ 
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 Keep Your Backups Safe 

We recommend that you back up your data each day and store it in a secure, off-site location. After all, 

what's the point of backing up your data if it's destroyed during a disaster? 

 

Jim was lucky that his backups stayed safe during the tornado. But as an extra precaution, Paula is going 

to ask Saint Mary's diocese if she can keep her flash drives at their weatherproof storage building. 

 

When planning for the budget next year, Paula may even consider moving to PDS OnDemand so that 

Saint Mary's data can be hosted on a secure server. 

 

 

 Now it's your turn 

1.   What's your parish's backup plan? If you don't have one or need to improve on the current plan, 

write it here. 

 

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________ 

 


